SAP2000 v24.1.0 Release Notes
© 2022 Computers and Structures, Inc.

Notice Date: 11-October-2022
This document lists changes made to SAP2000 since v24.0.0, released 11-March-2022. Items marked
with an asterisk (*) in the first column are more significant.
Analysis
Enhancements Implemented
*
*

Ticket
896

Description
A change has been made to the reporting of joint reactions and base reactions for nonlinear
static and staged-construction load cases. Previously joint-force loads and acceleration loads
applied at restrained degrees of freedom were excluded from the reported joint reactions at
these degrees of freedom, including their contribution to overall base reactions. This was
intentional for matching the reactions to the force reported in the connected frame objects
when performing pushover-types of analyses. However, this is now changed to be consistent
with the reactions reported for most other types of load cases, including linear static,
nonlinear direct-integration time history, and modal time history, including FNA. This is a
reporting issue only. No other results are affected, including the reactions at flexible
supports (spring support and one-joint links). The only change in restraint reactions will be
due to joint-force loads applied directly on the joint and apportioned acceleration loads
from connected objects, including from mass directly assigned to the joint.

API
Enhancements Implemented
*

Ticket
8406
8414

*

8449

8875

Description
A new page has been added to the API documentation with guidance on creating a client
application using .NET 6. This can be found in the Release Notes section of the
documentation.
The Application Programming Interface (API) has been enhanced with the addition of
functions get and set design preferences and design overwrites for steel frame code CSAS16-19.
The following enhancements have been made to the Application Programming Interface
(API): (1.) The new function cHelper.GetObjectProcess() can be used to attach to any running
instance of SAP2000 given its process ID. (2.) A new command "Set as active instance for
API" has been added to the Tools menu. This command will make the current instance of
SAP2000 the "active instance" so that it will then respond to subsequent calls to
cHelper.GetObject() function. If the current instance is the active instance, then this
command is disabled. In either case, the process ID of the current instance is displayed with
the menu command for use with the new function cHelper.GetObjectProcess(). (3.) A new
interface cPluginContract has been added to simplify plugin development. (4.) Speed has
been improved for external .NET clients that call the API by chaining properties and methods
(e.g. mySapObject.SapModel.PointObj.GetElm) in deeply nested loops.
The Application Programming Interface (API) was enhanced so the function
SapModel.PropFrame.GetPropFileNameList() can now retrieve names from .XML section
property files, in addition to its current retrieval of names from .PRO files.
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Data Files
Enhancements Implemented
*

Ticket
8119

8486
8769

Description
Three new section-property database files have been added for steel sections produced by
certain Indian manufacturers: (1.) TATA_Steel.xml, containing data for steel Pipe/Tube
sections manufactured by the TATA group of companies. (2.) Jindal_Steel.xml, containing
data for steel I/Wide Flange sections manufactured by Jindal Steel Ltd. (3.) APL_Steel.xml,
containing data for steel Pipe/Tube sections manufactured by APL Apollo Ltd.
A built-in material library has been added for Canada. The library contains steel materials
per the CSA G40.20-13/G40.21-13 standard, concrete materials per the CSA A23.3 standard,
and rebar materials per the CSA G30.18:21 standard.
The Chinese frame-section database has been updated where section properties for some of
the frame sections have been corrected and several new frame sections have been added
for I/Wide Flange, Tee, Angle, and Pipe shapes.

Design – Aluminum Frame
Enhancements Implemented
*

Ticket
8873

Description
An enhancement has been made to the EN 1999:2007 aluminum frame design to improve
the calculation of the C1, C2, and C3 factors. It includes more appropriate determination of
the unbraced length and the moment diagram, resulting in a less conservative value of the
C1 factor. Previously, the design algorithm was not identifying the bracing point at the
intersection of two frame members. This intersection was within the length of the member
that was not divided into two elements and whose design was performed over the entire
length. Consequently, the condition of the moment diagram used to determine C1, C2, and
C3 was incorrect. In addition, to give the users more flexibility, an option to select the
method of calculating C1, C2, and C3 is added in the design overwrites including the one
specified in Tables I.1 and I.2 in the Annex I of the EN 1999:2007, the one applied to general
moment diagrams as shown in EN 1999:2007 Annex I Eq. I.9, and input by the users. The
issue with the bracing point at the intersection of two frame members is also resolved for
the AA 2015 and AA 2020 aluminum designs.

Design – Cold Formed Frame
Enhancements Implemented
*

Ticket
8874

Description
An enhancement has been made to the Eurocode 3 1-3 2006 cold-formed steel frame design
to improve the calculation of the C1, C2, and C3 factors. It includes more appropriate
determination of the unbraced length and the moment diagram, resulting in a less
conservative value of the C1 factor. Previously, the design algorithm was not identifying the
bracing point at the intersection of two frame members. This intersection was within the
length of the member that was not divided into two elements and whose design was
performed over the entire length. Consequently, the condition of the moment diagram used
to determine C1, C2, and C3 was incorrect. In addition, to give the users more flexibility, an
option to select the method of calculating C1, C2, and C3 is added in the design overwrites
including the one specified in EN 1993-1-1:1992, the one applied to general moment
diagrams as described in Section F.1(c) of the AISC 360-16, and input by the users. The issue
with the bracing point at the intersection of two frame members is also resolved for the AISI
2016 cold-formed steel design.
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Design – Concrete Frame
Enhancements Implemented
*

Ticket
8893

Description
An enhancement has been made to the concrete frame design to make the reporting of the
joint shear details and the beam/column capacity ratios more consistent and complete in
the “Design Details: ETABS Concrete Frame Design” form. Now these results will only be
reported at the top station of the columns, and only for certain codes and under the
appropriate conditions. When these results are not reported (including at stations other
than the top of the column), a message listing the required conditions will be provided. This
affects the ACI 318-19, ACI 318-14, ACI 318-11, ACI 318-08, AS 3600-2009, AS 3600-2018,
CSA A23.3-14, CSA A23.3-19, IS 456-2000, KBC 2009, KBC 2016, Mexican RCDF 2004,
Mexican RCD 2017, TS 500-2000 and TS 500-2000(R2018) design codes. This is only a
reporting change and design results are not affected.

Design – Slab
Enhancements Implemented
*
*

Ticket
8288

Description
An enhancement has been made to the concrete shell design per Eurocode 2-2004 to
include a check for cracking in concrete and the design of transverse shear reinforcement in
accordance with Annex LL of Eurocode 1992-2:2005.

Design – Steel Frame
Enhancements Implemented
*

Ticket
4998

6596

Description
An enhancement was made to the Chinese 2018 steel frame design code where now the
design will still display the stability check equation information with most of the terms
shown as zero and with the calculated phiB factor even when the design preferences or
overwrites are set with "Ignore beam phiB" as "Yes". Previously, in this case, the information
was displayed for the stability check by setting the phiB factor to 1.0.
An enhancement has been made to the Eurocode 3-2005, Italian NTC 2008, and Italian NTC
2018 steel frame design to improve the calculation of the C1, C2, and C3 factors. It includes
more appropriate determination of the unbraced length and the moment diagram, resulting
in a less conservative value of the C1 factor. Previously, the design algorithm was not
identifying the bracing point at the intersection of two frame members. This intersection
was within the length of the member that was not divided into two elements and whose
design was performed over the entire length. Consequently, the condition of the moment
diagram used to determine C1, C2, and C3 was incorrect. In addition, to give the users more
flexibility, an option to select the method of calculating C1, C2, and C3 is added in the design
overwrites including the one specified in EN 1993-1-1:1992, the one applied to general
moment diagrams as described in Section F.1(c) of the AISC 360-16, and input by the users.
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*

Ticket
7212

8595

Description
An enhancement has been made to the Canadian steel frame design codes "CSA S16-19",
"CSA S16-14", and "CSA S16-09" codes where now the section class ("H" or "C") of the HSS
box and pipe sections can be overwritten in the Overwrites form. This enhancement
simplifies the class determination and calculation of the power n of HSS sections, which is
used for axial compression capacity calculation per CSA 13.3.1 for flexural-buckling mode.
Previously, and still by default, the value of n is taken as 1.34. However, if a section name
prefix is "WWF" for an I-shape, n is taken as 2.24. For box and pipe sections, if the section
name prefix is "HSS" or "HS" and the name postfix is "H," the value of n is taken as 2.24. If
the postfix is "C" instead of "H," n is taken as 1.34 for box and pipe sections. For all other
sections, n is taken as 1.34, except if any plate thickness is greater than 25.4mm, in which
case n is taken as 1.0. By default, the overwrite item "Is HSS section Cass H?" is taken as
"Program Determined, " meaning the previous procedure remains in effect. With this
enhancement, the section class can be directly specified as an overwrite and the HSS section
name does not need to be modified with a postfix anymore. If the section is not a box or
pipe section, or if the member is not overwritten, there is no change in result. The value of n
for torsion or torsional-flexural buckling mode is taken as 1.34 per CSA 13.3.1, and
unaffected by the changes in this ticket.
The “Chinese 2018” steel frame design code now has improved reporting of the appropriate
load amplification factorN (0.8 vs. 1.25) used for Euler buckling of Double Angle, T-section,
and Channel sections. Generally, the amplification factor is 1.0 / (1.0 - factorN * N / N_E),
where the factorN = 0.8 for all sections with some exceptions: for the Double Angle and Tsections, factorN is 1.25 when considering the major direction, and for the Channel sections,
factorN is 1.25 when considering the minor direction (GB50017-2017 8.2.1-1 =0.8, 8.2.1-4
=1.25, 8.2.4-1 =0.8, 8.2.5-1 =0.8, 8.2.5-2 =0.8). Previously the value of factorN was only
reported when it was equal to 0.8. Now it will also be reported when the value is 1.25. This
is a change in reporting only. In both cases, the correct value was used internally and design
results are not changed.

External Import and Export
Enhancements Implemented
*

Ticket
7218

8864

8899

Description
An enhancement to the export of vertical shell objects to .EXR files has been implemented.
Vertical shell objects with a sloping base are now exported. Walls with a clearly sloping base
(more than 2 degrees off the horizontal and more than one-eighth of an inch difference in
base elevations) are exported with their actual geometry, while walls with a slightly sloping
base are exported with a rectified base and a corresponding warning in the .EXR log file.
Previously, vertical shell objects with a sloping base were omitted from the export, with a
corresponding warning in the .EXR log file.
An enhancement to the import and export of Revit .EXR files was implemented. SAP2000
supports new features introduced in CSiXRevit 2023, namely the import of the new Revit
analytical links, and the export of structural column cardinal-point offsets. SAP2000 remains
compatible with earlier versions of CSiXRevit.
An enhancement to the import of Revit .EXR files was implemented. When importing Revit
steel frame member family types, SAP2000 attempts to match each Revit frame member
family type to an identically named section profile defined in the default .XML property file,
or in one of the user-specified .XML or .PRO property files. Now the name comparison
ignores blank spaces, meaning that "W12 x 14" and "W12x14" are considered equivalent.
The SAP20000 sections are imported with their original Revit names, including any blank
spaces originally present.
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Graphics
Enhancements Implemented
*

Ticket
7105

8767

8768

Description
An enhancement has been made to allow users to choose colors for Hinge State and Hinge
Status for analysis of models with nonlinear frame hinges. This can be accessed using menu
command Options > Color > Output. The colors are now consistent in deformed-shape
display, plots of hinge force-deformation, and in the forms where the nonlinear properties
are specified.
An incident was resolved where the maximum and minimum font sizes set in the
Dimensions/Tolerances Preferences form were not being properly applied to printed
graphics. Now the behavior should be similar to the effect of these font sizes on the screen
display, with adjustments for the size of the printed image.
An incident was resolved where the Maximum and Minimum Font Sizes used for drawing
text and symbols in the graphical model windows were not consistent between the two
graphics modes, DirectX and Classical Plus (GDIPlus). Now the two graphics modes are more
are more nearly consistent in how they vary the font size with distance from the front of the
view. Note that these font sizes can be set using the command Options > Dimension
Tolerances.

Installation and Licensing
Enhancements Implemented
*
*

Ticket
8269

Description
The version number has been changed to v24.1.0 for a new intermediate release.

Results Display and Output
Enhancements Implemented
*

Ticket
8766

Description
An enhancement has been implement that allows users to specify the scale when printing
graphics to a printer or a PDF file. The option is available for both the Classic Plus and
DirectX graphic modes. The scaling for the graphics being printed can be specified using the
drop down box on the print preview form.

Structural Model
Enhancements Implemented
*
*

Ticket
8380

*

8593

Description
The program-calculated yield forces, yield moments, and interaction surfaces for reinforcedconcrete type nonlinear hinges have been changed to use the expected strength of the rebar
material. Previously, the minimum strength was used for the program-calculated values.
Models from previous versions that are re-run in the new version may produce somewhat
different results due to this change in the common case where the expected strength of the
material is slightly larger than the minimum strength.
The viscous damper type link properties "Damper - Exponential" and "Damper - Bilinear"
(Define menu > Section Properties > Link/Support Properties) have been enhanced to add a
Fixed Length Damper option for the axial (U1) degree of freedom. When enabled, the Fixed
Length Damper option allows the user to define the damper length as a fixed value and the
modulus of elasticity and cross-sectional area for the extender which will span the additional
length of the link that is not taken up by the damper. For analysis, the extender is effectively
a linear spring that is in series with the damper. Note that this is in addition to the stiffness
specified for the damper itself, which is primarily due to the fluid column in the device, and
whose value should be obtained from the manufacturer of the device. The stiffness of the
damper and the extender, when present, act in series so that their flexibilities are additive.
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Analysis
Incidents Resolved
*

Ticket
902

8218

*

8437

*

8514

*

8607

*

8687

Description
An incident was resolved where the reported joint reactions did not always include the load
applied to the joints for certain types of linear load cases, whether the load was applied
directly on the joint or on connected elements. These load cases included linear directintegration time history, linear frequency-domain time history, steady state, and PSD types.
This issue only affected the reported reactions at restrained joints that included force loads,
acceleration loads, and/or temperature/strain loads from connected elements, as well as
force loads on the restrained joints themselves. Similarly affected were the reactions due to
ground-displacement loads applied at joints grounded by springs. Reactions due to
displacement loads on joints grounded through restraints or one-joint links were not
affected. This was a reporting error only. No other results were affected.
An incident was resolved where link elements with a triple-pendulum property that had the
U2 and/or U3 degrees of freedom set to linear did not use the specified linear effective
stiffness in nonlinear load cases. The triple-pendulum link property has been changed so
that now the U2 and U3 degrees of freedom are always nonlinear, similar to the U1 degree
of freedom. Older models that had triple-pendulum link properties with the U2 and/or U3
degrees of freedom set to linear will have these degrees of freedom changed to nonlinear
upon opening the model in SAP2000 v24.1.0. For such older models, the nonlinear
properties will default to zero unless they had been previously defined, and this may make
the model unstable or change the behavior from the previous version. Note that such
models are uncommon, but they should be updated with realistic nonlinear values for
affected triple-pendulum property definitions.
An incident was resolved where link elements with a viscous damper property (Linear with
non-zero damping coefficients, Exponential Damper, or Bilinear Damper) could experience
forces that did not correspond to the velocity of the element. This issue only occurred in
direct-integration time-history analyses where the Geometric Nonlinearity option was set to
"P-Delta plus Large Displacements". When this issue occurred, the damper elements notably
did not return to a small or nearly-zero force value after the structure had come to a
standstill.
An incident was resolved where the flexibility of fiber hinges in frame objects was not
included in the stiffness-proportional damping used for direct-integration time-history load
cases. This issue was most apparent when all or most of the frame-object length was
modeled as fiber hinges and resulted in very large stiffness-proportional damping forces
which could prevent the frame object from experiencing significant deformations in timehistory analyses. The effect on frame objects with fibers hinges that covered a small part of
the object length was significantly less pronounced. This issue was only present in SAP2000
v24.0.0 and did not affect older versions of the software. This issue only affected directintegration time-history load cases where stiffness-proportional damping was used. Models
that were affected by this issue should be rerun in the new version.
An incident was resolved where the program-generated load case for computing accidental
eccentricity (~Torsion) in a response spectrum load case always started from the initial state.
This behavior has been changed so that the accidental eccentricity load case will use the
stiffness consistent with the modal load case specified in the response spectrum load case.
Using the wrong stiffness state for the torsional load case could lead to inconsistent
torsional results when there were significant P-delta or other nonlinear effects in the modalstiffness load cases, or if the structure was different between the stiffness states due to
staged-construction. In most common situations, the effect was minimal.
An incident was resolved where response spectrum load cases exported to SAFE did not
properly consider the additional eccentricity loads. Now the eccentricity effects will be
properly exported to SAFE versions 20.3.0 and later.
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*

Ticket
8798

*

8805

Description
An incident was resolved where, for the coupled concrete material in the layered shell
element, the compression strength reduction under perpendicular tensile strain was not
applied when the compression was in the linear range (not yielded). For locations where a
large tensile strain was experienced in one direction while the perpendicular compressive
behavior was linear, the material could have experienced a sudden drop in compression
strength after reaching the unreduced compressive yield strength.
An incident was resolved where a model that had P-M3 Fiber hinges assigned to frame
objects may have experienced larger than expected stiffness-proportional damping in linear
direct-integration time-history load cases when stiffness-proportional damping was enabled.
This issue was more pronounced when the hinge length was a significant portion of the
length of the frame. This issue only affected models where the analysis model for nonlinear
hinges option (Analyze menu > Analysis Model for Nonlinear Hinges) was set to "Model
Hinges as Separate Link Elements". This issue did not affect static, modal, or nonlinear
direct-integration time-history load cases, and it did not affect models where the hinges
were modeled within elements. This issue affected SAP2000 versions 22.1.0 to 24.0.0. The
effect was rarely significant.

API
Incidents Resolved
*

Ticket
7676

8907

Description
An incident was resolved for the Application Programming Interface (API) where the wind
direction angle (DirAngle) value was not set or retrieved when the ExposureFrom value
included frame objects (value of 3 or 4). This affected the API 4F 2008, API 4F 2013, ASCE 702, ASCE 7-05, ASCE 7-10, and ASCE 7-16 auto wind API functions.
An incident affecting the Application Programming Interface (API) was resolved. When
importing a
section from an .XML section properties file, the function PropFrame.ImportProp() did not
account for its first parameter
"Name", but instead always named the newly imported section after its
designation in the .XML file. Sections imported from .PRO section properties files were
correctly given the requested Name parameter. This issue affected versions 23.3.0 to
v24.0.0, but it had no effect on results when it occurred.

Data Files
Incidents Resolved
*

Ticket
8111

8332

Description
An incident was resolved to fix incorrect or missing torsional constant (J) values for double
angles in the AISC14, AISC15, AISC14M and AISC15M XML section libraries. In these XML
section libraries, the J value for the double-angle sections were either incorrect or missing.
Upon import, missing J values were calculated (using formulas if the fillet radius was zero or
using FEM analysis if fillet radius was present), but the calculated values were different from
the expected values that should be twice that given in the same sections database for the
single angle comprising the double angle. This change involved updating the incorrect or
missing J values using the J values as available for the corresponding single angles in the
same section library.
An incident was resolved where response-spectrum function data files immediately failed to
load without checking the model folder when the function definition referenced either a
relative file path or a non-existing file path, and resulted in zero loading for the affected
function. Response-spectrum function definitions referencing full, valid data file paths were
not affected. This issue only affected version 24.0.0.
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*

Ticket
8909

Description
An incident was resolved where importing a model from a database-table file that had areaobject joint offsets and/or thickness overwrites assigned using the joint-pattern option
would cause an error and the assignments would not get imported. The issue affected the
import through all of the available database-table formats (text, Excel, Access, XML). Import
of area-object joint offsets and/or thickness overwrites specified directly by joints was not
affected.

Database Tables
Incidents Resolved
*
*

Ticket
8306
8731
8749

8771

Description
An incident was resolved where step-by-step hinge response tables failed to display when
response for a linear or nonlinear, modal or direct-integration time history load case was
requested. This was a display issue only and the results were otherwise not affected.
An incident was resolved where database import using an XML file and the Add to Existing
Model option did not work.
An incident was resolved where, in some instances, the LoadSF field in the "Case – Steady
State 2 – Load Assignments" database table was not displayed or exported. When this
occurred, the load-case data could be incorrect after importing an exported file or editing
the table in the interactive database editor.
An incident was resolved for certain steel frame design codes where the frame design
overwrites items "FrameType", "LLRat", "LLAbs", "ElemType", and "SDG" were not saved
properly when they were modified through the Tables using the Interactive Database Editor.
The affected codes were: "AISC-ASD89", "AISC-LRFD93", "API RP2A-WSD2000", "API RP2AWSD2014", "API RP2A-LRFD 97", "ASCE 10-97", "BS5950 2000", "Chinese 2010", "Chinese
2018", "CSA S16-19", "CSA S16-14", "CSA-S16-09", "Eurocode 3-2005", "Italian NTC 2018",
"Italian NTC 2008", "Italian UNI 10011", "Indian IS 800:2007", "KBC 2009", "KBC 2016",
"Norsok N-004 2013". The last two items were only applicable to the "Chinese 2018" code.
This issue affected versions 21.0.0 to 24.0.0. The overwrites could be updated using the
Design Overwrites form without any problem.

Design – Aluminum Frame
Incidents Resolved
*

Ticket
8719

Description
An incident has been resolved for the EN 1999:2007 aluminum frame design in which the
software could terminate abnormally when designing aluminum frame objects with general,
circular, or rectangular sections.

Design – Cold Formed Frame
Incidents Resolved
*

Ticket
8481

*

8634

Description
An incident has been resolved to correct the calculation of effective section moduli for
symmetric cold-formed sections under negative moment. These sections include C, C with
lips, hat, hat with lips, Z, and Z with lips. Previously, the effective modulus due to negative
moment was slightly incorrect due to the effective neutral axis being calculated using the
outside height (or width) of the section instead of those measured from the centerlines of
the webs or flanges. The effect on design results was insignificant. There was no error for
positive moment. In addition, the extruded view of cold-formed Z sections is also fixed to be
shown in undeformed shape, which was incorrectly displayed only in v24.0.0.
An incident was resolved for the AISI 2016 cold-formed steel frame design where the
governing design could be reported incorrectly if pattern live load was included in any of the
design load combinations. When this occurred, the last load combination that included
pattern live load was reported instead of the governing load combination. This could be
unconservative. This error did not occur if none of the design load combinations included
pattern live load.
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*

Ticket
8715

Description
An incident has been resolved for the AISI 2016 cold-formed steel frame design in which the
major and minor moment demand-capacity (D/C) ratios were incorrectly swapped when the
design section was in tension and the combined D/C ratio was governed by Equation H1.1-2.
This was only a display issue in the design report. The design results were not affected.

Design – Concrete Frame
Incidents Resolved
*

Ticket
7401

7403

8886

8952

Description
An incident was resolved for concrete frame design code "Chinese 2010" where the
concrete frame
design details have been changed in two places: (1) The term Shear Span Lambda has been
changed
to L0/b. (2) The unnecessary term Lambda has been removed from the paragraph "Axial
Compression Ratio". These were reporting issues only. There is no change to the design
calculations or results.
An incident was resolved for
concrete frame design code "Chinese 2010" where the shear reinforcement shown in design
details did not match with
that shown in the "Column Design Information" form or that shown in
the "Concrete Details 1 - Column Summary Data - Chinese 2010"
database table. The shear
reinforcement shown in the design details was correct. The "Column Design Information"
form and
the "Concrete Details 1 - Column Summary Data - Chinese 2010"
database table consistently showed the same wrong value. This was a display issue only. All
detailed
calculations were correct.
An incident was resolved for concrete frame design codes "Eurocode 2-2004" and "Italian
NTC 2008" in which the beam/column capacity ratio was being calculated as the ratio of the
sum of the design moment capacities of the beams (with design values of gamma_c and
gamma_s) to the sum of nominal moment capacities of columns (with gamma_c = 1,
gamma_s = 1). In both cases, the design values of the moment capacities with appropriate
strength reduction factors gamma_c and gamma_s are now used per EN 1998-1:2004
sections 4.4.2.3(4) and 5.2.3.3(2). The previous implementation was unconservative.
An incident was resolved for Mexican RCDF 2014 and 2017 concrete frame design codes
where computation of the u factor was incorrect. The u factor was computed based on
sustained and total moments instead of sustained and total axial load.

Design – Slab
Incidents Resolved
*
*

Ticket
8295

Description
An incident was resolved in which the design values were not reported correctly in the
Concrete Shell Design table for envelope-type load combinations. Now, the design values
reported (As1Top, As1Bot, As2Top, As2Bot, V1Ratio, and V2Ratio) for an envelope-type load
combination are the envelopes (only maxima) over all the designs for each contained load
case or load combination, including over all the steps within each of these load cases or
combinations. The same is true for each contained lower-level, envelope-type load
combination, except that an envelope-type combination will utilize the envelopes of the
shell forces rather than envelopes of shell designs if it is contained within a higher-level,
non-envelope load combination. For most practical cases, it can simply be stated that
envelope-type load combinations produce the more meaningful envelope of shell designs
for different sets of forces rather than the design for the envelope of these forces. Note that
when the top-level load case or combination is of envelope type, Max and Min results are
produced: the design results for both sets are the Max values, and the Max and Min refers
to the reported values of the shell forces.
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*
*

Ticket
8370

Description
An incident was resolved to correct the design of concrete shell elements with only a single
layer of reinforcement in the middle of the section. Previously, after the design was
performed for the top and bottom layers of concrete, only the results for the top layer were
reported. This resulted in zero reinforcement being reported if only the bottom concrete
layer required reinforcement. Now the single layer of reinforcement at the middle that is
required to satisfy the design for both the top and bottom layers of concrete will be
reported correctly. Note that it is reported as being for the top layer in the contour plot and
table for concrete shell design results, although it applies for both positive and negative
bending, as applicable.

Design – Steel Frame
Incidents Resolved
*

Ticket
4816

5512

*

7856

7976
8301

8317

8382

8430

Description
An incident was resolved for steel frame design code "AISC 360-16" where, when using
SCBF, the results were reporting "Section is not seismically compact for moderately ductile
members" instead of "Section is not seismically compact for highly ductile members", as per
AISC 341-16 section F2-5a.
An incident was resolved for the "AISC 360-16" steel frame design code where the HSS
minor-axis moment capacity was taken as the fully plastic moment capacity irrespective of
section compactness for minor-axis bending when the web was compact for major-axis
bending. Now the minor-axis moment capacity is calculated based on the section
compactness for minor-axis bending. Previous results were correct for compact sections, but
were unconservative for noncompact and slender sections under minor-axis bending when
the web was compact for major-axis bending.
An incident has been resolved for the Eurocode 3-2005, Italian NTC 2008, and Italian NTC
2018 steel frame design codes to perform the design of angle sections about the principal
axes instead of the geometric axes. The design includes the calculation of the design
moments, the effective section moduli (Weff,y and Weff,z), the plastic section moduli (Wpl,y
and Wpl,z), the equivalent uniform moment factor (Cm), the critical moment coefficients
(C1, C2, and C3), etc. Previously, these design parameters were computed about the
geometric axes.
An incident was resolved for steel frame design codes "Chinese 2018" and "Chinese 2010"
where the shear-stress calculation in the minor direction was incorrect for box sections. The
previous calculation was conservative, giving higher stress ratios as the stress was doubled.
An incident was resolved for certain steel and other metal frame design codes where the
critical buckling capacity was not calculated correctly for unequal-legged angle sections
having web height (t2) greater than flange width (t3). However, the critical buckling capacity
was calculated correctly for equal-legged angle sections and for unequal-legged angle
sections with flange width (t3) larger than the web height (t2). The affected codes are as
follows: (a.) Steel: AISC-ASD89, AISC 360-10, AISC360-05/IBC2006, AISC-LRFD93, API RP2ALRFD 97, API RP2A-WSD2014, API RP2A-WSD2000, Chinese 2018, CSA S16-19, CSA S16-14,
CSA-S16-09, Indian IS 800:2007, KBC 2009, KBC 2016, SP 16.13330.2017, SP 16.13330.2011.
(b.) Aluminum: AA 2015, AA 2020. (c.) Cold-formed Steel: AISI-ASD96, AISI-LRFD96.
An incident was resolved for the CSA S16-14 and CSA S16-19 steel frame design codes where
the section classification limits reported in Table "COMPACTNESS" may have been incorrect
for I-shaped, channel, and double channel sections. This was a reporting issue only and
design was not affected.
An incident was resolved for steel frame design code "Chinese 2018" where the reported
interaction equation name was wrong when "Classify Beam as Flexo-Compression
Member?" was set to "Yes". The program reported the equation name as "GB50017 8.2.5"
while it was supposed to be "GB50017 6.2.3". The reported ratio was correct. No other
results were affected.
An incident was resolved for CSA S16-19 steel frame design where the design
documentation for angle section bending capacity was referencing the sections from the
AISC 360-16 code instead of CSA S16-19. The document has been updated to reflect the
reference sections from CSA S16-19.
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*

Ticket
8526

8577

Description
An incident was resolved for displaying and exporting the interactive database tables
'Overwrites - Steel Design - Italian NTC 2008' and 'Overwrites - Steel Design - Italian NTC
2018'. Previously these tables would not be displayed nor export the data of shear forces
Vc2Rd and Vc3Rd to the .s2k text file. As a result, the values of Vc2Rd and Vc3Rd are not
imported from the .s2k text file generated from v24.0.0. These Vc2Rd and Vc3Rd values are
read properly when opening the .sdb file of any version. Design results agree with the model
and overwrites visible in the user interface.
An incident was resolved for steel frame design to remove the display of the section class
from the deflection-check detailed report for the codes AISC360-05/IBC2006, AISC 360-10,
AISC 360-16, AS 4100-1998, Eurocode 3-2005, Italian NTC 2018, Italian NTC 2008, Indian IS
800:2007, NZS 3404-1997, KBC 2009, and KBC 2016. The section class is not applicable to the
deflection check, and the section class reported could be wrong in the sense that it was not
the same as that reported for strength design.

Documentation
Incidents Resolved
*

Ticket
7808

8257

8387

Description
An incident was resolved in the AS 4100-1998 steel frame design manual where the
equation for eta in section 3.7.3.2 of the design manual (AS 6.3.3) incorrectly showed 0.0326
instead of 0.00326. This was a documentation issue only. The design algorithm was using the
correct value.
An incident was resolved to correct the documentation for the Application Programming
Interface (API) for the functions in SapModel.EditGeneral. The documentation previously
listed these as EditSolid functions which was incorrect. This was a documentation issue only
and did not affect the API.
An incident was resolved for steel frame design codes "Eurocode 3-2005" and "Italian NTC
2018" where the description of the item "Consider Torsion?" in the Steel Frame Design
Preferences form indicated that torsion was checked for Channel sections in addition to the
I, Rectangular Hollow, Square Hollow, and Circular Hollow sections. Now the word "Channel"
has been removed from the list, since channel sections are not checked for torsion. This was
a change to the description only. Design behavior has not been changed, and now this
description is consistent with the manual and the actual design behavior.

External Import and Export
Incidents Resolved
*

Ticket
5555

8563

8589

Description
An incident affecting the import of Revit curved walls from .EXR files has been resolved.
Curved walls with notches at their bases or tops, such as curved walls with a door opening,
were not imported. When this occurred, the error was obvious and the .EXRLog file included
a message reporting the omission. Revit curved walls with notches at their bases or tops, or
the associated analytical panels in the case of Revit 2023, are now imported as expected.
An incident was resolved where large DXF files (around 80,000 CAD objects) did not import
into SAP2000, eventually running out of memory. DXF files with approximately 80,0000
objects can now be imported, subject to machine limitations. Three related enhancements
have been implemented: (1.) The import of DXF files is now faster. (2.) Arcs drawn on the
layer selected for importing frame objects are now imported as curved SAP2000 frame
objects instead of being tessellated into series of straight frame objects. (3.) "Lighweight"
polylines, drawn with the AutoCAD "Poly" command, are now able to be imported.
An incident was resolved where the models exported to Perform3D were only fully correct
when the database units in SAP2000 were either lb-in or lb-ft. The database units are those
in effect when a model is first created or imported in SAP2000. For SAP2000 models with
database units other than lb-in or lb-ft, the exported geometry and nodal loading were not
correct. Note that other features in the exported model, such as the various properties,
were not affected by this error.
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*

Ticket
8881
8883

8890

Description
An incident was resolved where the sign of the of the local-axis angle for horizontal and
inclined frame members was reversed when importing models from IFC files. This did not
affect frame members where the default orientation (zero angle) was used.
An incident affecting the export to Revit .EXR files of models featuring steel columns with
angle, tee, or channel sections has been resolved. These were exported to Revit with an
incorrect rotation which differed from the correct orientation by 180 degrees. Concrete
columns and steel column with rectangular, circular, pipe, tube, double-channel sections
were not affected because their orientation is unaffected by a 180 degrees rotation. Also
note that concrete column trapezoidal sections and steel double-angle sections are not
available in Revit. Beams and braces were exported with the correct orientation. This issue
affected all versions of SAP2000 capable of exporting .EXR files to Revit and when it
occurred, the error was obvious.
An incident affecting the import of IFC 4 files describing structures in terms of the IFC
"architectural coordination view" was fixed. The insertion point of all imported frame
objects was left at its default middle center position, even when a different insertion point
was specified in the IFC file. This error affected all versions of SAP2000 capable of importing
IFC 4 files and was visually obvious when it occurred. Frame object insertion points were
properly imported from IFC 4 files describing structures in terms of the IFC "structural view".

Graphics
Incidents Resolved
*

Ticket
4658
5438
5722
7092

7941
8065

8969

Description
An incident was resolved where the graphical user interface could become unresponsive
after clicking the "Rotate 3D View" toolbutton while displaying an animated deformed
shape. This issue did not affect Classical Plus (GDIPlus) graphics mode.
An incident was resolved where restraints were not displayed in the correct location when
animating the deformed shape in DirectX graphics mode for 2D views.
An incident was resolved where, when creating animation videos (command File > Create
Video), joints and their supports that were located behind other objects were shown instead
in front of those objects. This only affected DirectX graphics mode, not Classical Plus mode.
An incident was resolved for DirectX graphics mode where selecting the Back Face option
when using the command View > Set 2D View did not properly reverse the location of the
joint restraints in the X-Z and Y-Z planes. This issue did not affect the Classical Plus graphics
mode.
An incident was resolved where joint symbols were not displayed in the correct locations in
exported EMF graphics files.
An incident was resolved where the Highlight and Selection colors chosen using the
command Options > Colors > Display had no effect on the display. This has been corrected
for the Highlight color, while the selection color has been removed as it is no longer used.
Note that the Highlight color is only used in DirectX graphics mode. The highlight color
shows, for example, the member referenced in the selected row of a displayed table, or the
member under consideration during the design process.
An incident was resolved where joint offsets assigned to area objects with 3 or 4 points were
not shown in extruded views of the model when the area-object transparency was set to
zero (opaque). This only affected DirectX graphics mode. The joint offsets were correctly
shown in extruded views when the transparency setting was non-zero. No results were
affected
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Installation and Licensing
Incidents Resolved
*

Ticket
8956

Description
An incident was resolved with cloud licensing where a client machine running with a lower
level license could unexpectedly pick up a higher level license when a second instance was
started or the license was refreshed, and a higher level license was available in the same
account. Typically this would only happen when the higher level license was in use by
another machine when the client initially started the program, and the higher level license
was returned from the other machine while the client machine was still using the program.

Miscellaneous
Incidents Resolved
*

Ticket
7638

Description
An incident was resolved where certain object labels which could be construed as numeric
but were not meant to be (like 53E8), which could generate an error condition when saving
the model.

Results Display and Output
Incidents Resolved
*

Ticket
7011

7096

7788
8806

Description
An incident was resolved where information has been added on the Color selection forms to
clarify that in DirectX Graphics mode, screen colors are always used for printing. When greyscale printing is desired from DirectX, this can be selected in the printer settings rather than
in the SAP2000 Colors form.
An issue was resolved where the input energy from frame-element loading was not
calculated correctly in nonlinear analyses with the nonlinear geometry option set to "Large
Displacements Plus P-Delta". This issue caused large energy errors to be reported for
affected load cases. This was a reporting issue for the energy output only and did not affect
other analysis results.
An incident was resolved where the multivalued options were not enabled in the Display
Solid Stresses form.
An incident was resolved that addressed the following issues affecting the concrete frame
design reports for ACI 318-19, AS 3600-2018, and Chinese 2010 codes: (1.) For the ACI 31819 code, the table "Beam Capacities and Angles (Overstrength factor = 1.25, Phi(capacity) =
1.0)" presented in the design Joint Shear Details was showing the "Tension for +ve Moment"
and "Tension for -ve Moment" as zeros. (2.) For the AS 3600-2018 code, the Joint Shear
Details were not calculated and reported. This is now not available from the Concrete
Column Design Form. (3.) For the Chinese 2010 code, the table "Beam Capacities and
Angles" presented in the design Joint Shear Details was showing the "Tension for +ve
Moment" and "Tension for -ve Moment" as zeros. In addition, the resulting joint shear stress
ratios were wrong. The above items were only a reporting issue for the ACI 318-19 and AS
3600-2018 codes, and design results were not affected. For the Chinese 2010 code, the
design results were affected.

Structural Model
Incidents Resolved
*
*

Ticket
7195

Description
An incident was resolved where the capacity calculated for auto-M2 and auto-M3 SDOF
(single degree-of-freedom) hinges for a column-type concrete section was assuming the
total rebar to be distributed half on compression face and half on the tension face,
regardless of the direction of loading. The capacity will now based on the actual distribution
of rebar specified in the section property for column-type sections. This issue did not affect
any of the P-M2-M3, P-M2, or P-M3 hinges which would normally be used for column-type
sections.
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*

Ticket
7301

*

8282

8559

*

8578

8812

Description
An incident was resolved where the thicknesses of area section properties were not being
set correctly for models created through the Pipes and Plates new-model template when the
region for default materials was anything other than United States. Additionally, the
template was only creating a single default area section property even when the model for
the selected component type required multiple sections with different thicknesses.
An incident was resolved where the center-of gravity (CG) offsets for the 2 and 3 directions
were switched for user-defined channel frame sections (steel and cold-formed steel) that
had a zero fillet radius. This only affected channels directly defined, not channels that were
imported from a section-property database file (.PRO or .XML). Channel sections with a nonzero fillet radius were not affected. When this error occurred, the shear-center eccentricity
was increased by the amount of the CG offset, which could increase shear-torsion (V2-T)
coupling. In addition, when insertion points other than the default (10 - Centroid) were
used, they were off by the amount of the CG offsets, which would affect the coupling
between axial force P and bending moments M2 and M3. Results were consistent with the
CG Offsets and Shear Center Offset as reported in the Property Data form (Define > Section
Properties > Frame Sections > ModifyShow > Section Properties) and in the "Frame Section
Properties 01 - General" database table. This error affected versions 23.3.1 to 24.0.0.
Models opened in the new version will correct any affected channel section properties.
An incident was resolved where the properties of sections that were not available in the
XML section libraries were being set to zero when the sections were imported from the
respective libraries. All missing section properties for the section being imported are now
calculated at the time of import.
An incident was resolved where importing a channel section from a section library while
working in one of the new-model templates could cause the software to terminate
abnormally. This did not occur if the section was imported after the model had been created
from the template.
An incident was resolved where assigning nonlinear panel-zone properties to joints and
running a Ritz modal analysis with starting vectors based on Links would cause a warning
message in the analysis .LOG file that loads were being applied to one or more massless
degrees of freedom. To resolve this issue, the analysis model now adds a very small mass to
the to panel-zone degrees of freedom, based on the mass of connected frame objects. Note
that in spite of the warning, no significant effect on results was expected for this case, and
no significant change in results is expected with the new version. Only in certain uncommon
cases, the new version may provide better convergence behavior for nonlinear modal timehistory (FNA) load cases based on the affected Ritz modal cases if the nonlinear behavior
was dominated by the panel zones.

User Interface
Incidents Resolved
*

Ticket
7370

8334

Description
An incident was resolved for the export to Perform3D where some of the generated
property names were longer than 40 characters and were therefore not able to be imported
into Perform3D when the first 40 characters were common to more than one property. This
could occur because property names in Perform3D are limited to 40 characters. Now all
generated property names are limited to 40 characters and are unique.
An incident was resolved where the values for analysis-model items (point, line, area, plane,
solid, and link elements) in the right-button click properties form did not update when the
units were changed in the drop down box in the form. Instead they remained in the units
shown in the lower right corner of the graphical user interface. This affected the display of
the analysis model (meshed elements), not the display of the drawn objects. This was a userinterface issue only and did not affect results.
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